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tools for Java EE and JSF, Mylyn and others. More...

Downloads: 634,405 Linux 64bit
Eclipse IDE for Java Developers (85 MB) Windows
The essential tools for any Java deweloper, including a Java IDE, a CVWS client, XML Editor Mac 0S X

X 32bit
1ux G4hit

and Mylyn. More...
Downloads: 346,631

Eclipse IDE for C/C++ Developers (68 MB)
An IDE for CIC++ developers with Mylyn integration. More...
Downloads: 150,696

Featured Member Distro
Yoxos
Eclipse Ganymede and hundreds of additional plug-ins - served by the Yoxos CnDemand download partal

Eclipse Modeling Tools (includes Incubating ¢components) (313 MB)
This modeling package contains a collection of Eclipse Madeling Project carmponents,
including EMF, GMF, MDT XSDIOCLUMLZ, M2M, M2T, and EMFT elements. It includes a
camplete SOK, developer tools and source code. Mote that the Modeling package includes

=0me incubating components, as indicated by feature numhbers less than 1.0.0 on the - -
feature list. More... Linusc Gabit
Downloads: 43,492

Eclipse for RCP/Plug-in Developers (176 MB) Windows
Acomplete set oftools for developers who wantto create Eclipse plug-ins or Rich Client Mac 0S X
Applications. It includes a complete SDK, developertanis and saurce code, plus Myyn, an G 0L
HML editor and the Eclipse Communication Frarmework. More... Lirnu 64bit
Downloads: 27,649

Eclipse IDE for Java and Report Developers {196 MB) Windows
Java EE tools and BIRT reporting tool for Java developers {0 create Java EE and YWeh ac0OS X
applications that also have reporting needs. More... 1 32bit
Downloads: 24,810 Linux 64bit

Eclipse Classic 3 152 MB

The classic Eclipse download: the Eclipse Platform, Java Development Tools, and Plug-in
Development Ervitonment, including source and both user and programrmer
documentation. More...

Release notes | Other downloads | Documentation

Downloads: 358,583

Linux 64bit
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= YWorkspace Launcher .

Select a workspace

Eclipse SDK stares vour projects in a folder called a workspace,
Choose s workspace folder to use for this session,

Warkspace: |Ci¥Documents and SettingsWjhnoteworkspace| ™

[ 1Use this as the default and do not ask again

| (814 | [ Cancel ]
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| Java - Eclipse SDK .
File Edit Navigate Search Project Bun Window 'Help
() Welcome 53 LJ@E
| E (@) Help Contents
. @ Search
Dynamic Help

‘@ﬂelcume B =5

Key Assist,.. Ctrl+Shift+L
Tips and Tricks...
Cheat Sheets, ,,

About Eclipse SDK

eclipse £ H&stD, Help -> Software Updates 41 Ef

& Java - Eclipse SDK
File Edit Mavigate Search Project Aun  Window Help

Welcome 82

= Software Updates and Add-ons

Installed Software | Availabls Software |

Name Wersion Update. .

uEclipse SR 3,42 MZ00902T1-1700

Uninstall,,.

Properties

Fevert Configuration,,,

Open the "Automatic Updales preference page to set up an automatic update schedule,

®
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X0| 20| Available Software EiS MEHSIT, Add SiteHEE +2C}

= Software Updates and Add-ons @

Installed Software | Available Software

type filter text

MName Wersion

% [] % Ganymede Update Site
e D\{I The Eclipse Project Updates

Add Site,,,

Manage Sites, .,

Refresh

Show only the latest versions of available software
[Jinclude iterns that have already been installed

Open the "Autormatic pdates” preference page to set up an automatic update schedule,

3)

Close

Jd2{™ Cte1} 20| Add Site 2t= @ Xt0| L}EFHCE O] BXO| Location: €8 xH0| Ct2 1t
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http://dl-ssl.google.com/android/eclipse/
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Installed Software | Available Software
type filter text -
MName Yersion
[ %l Ganymede Update Site
O \r:] https://dl-ssl. google, com/android/eclipse/ 5 -
% [ % The Eclipse Project Upda?
= Add Site

EIEETR
Location: |http://dl-ssl . google, com/android/eclipse/ | :

Refresh

()] [ []4 ] [ Cancel ]

Show only the latest versions of available software
[include itemns that have already been installed

Open the "Autornatic Updates” preference page to set up an autornatic update schedule,

Close
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< Software Updates and Add-ons

1]

Installed Software | Available Software

type filter text
MNarne Wersion
= [ % Ganymede Update Site
= D\{I http://dl-ssl.google, comandroid/eclipse/

+ []000 Developer Toals
CN | 4| The Eclipse Project Updates

Show only the atest versions of available software
[include itemns that have already been installed

Open the "Automatic Updates” preference page to set up an autornatic update schedule,

Add Site, .,

[ Manage Sites,

Close

OlCZ0|C E1010] £7} £, HABAIZ 8 =1 installS Z2lstc}

= Software Updates and Add-ons

=%]

Installed Software | Awailable Software

type filter text

MName Yersion
# [ %) Ganymede Update Site
- \{I hitp://dl-ssl, google, com/android/eclipse,/
= [#]000 Developer Taols
[#] ¥ Android Development Toals 0,8,0,+200803220536-110569
[#] % Andraid Editors 0.8,0,v200809220836-110569
¥ D\ﬁj The Eclipse Project Updates

Show only the |atest versions of available software
[include iterns that have already been installed

Open the "Automatic pdates” preference page to set up an autornatic update schedule,

Add Site, .,

Manage Sites,,,

Refresh

Close
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= Software Updates and Add-ons

Installed Softwars | Available Software |

J&E
type filter text -

MName Yarsion Install,,,

%] Ganymede Update Site

= 0: hitp://dl-=5l. google, corn/android/eclipse/

Properties
= [ D_evelopelr Tools Progress Information
[ 4 Android Develo
[ % Android Editars) = Calculating requirements and dependencies, Add Site, .,

14l The Eclipse Project 1 \l‘)

( ] Manage Sites, .,

Show only the |atest versions of available software
[Jlnclude items that have already been installed
Open the "Automatic [Ipdates” preference page to set up an automatic update schedule,

@
= Install = @
Install
Fieview and confirm that the checked items will be installed, \_) _|

ol

Mame ‘Wersion

LpEéndroid Development Tools 0.5, 0, 200809220536~ 110569

Lx Android Editors 0.8, 0,v200809220836-110569
Size! 8,373 KB
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= Install

o

Review Licenses
Licenses must be reviewed and accepted before the software can be installed,

Items with licenses:

Yersion
0,8,0,v200809220836- 110569
0,8,0,v200809220836- 110569

Mame
g+ Android Development Tools
gt Android Editors

>
o=

License text:

ANDROID SOFTWARE DEVELOPMEMNT KIT N
LICENSE AGREEMENT 1

1. Introduction

1,1 ¥our use of the Android Software Developrnent Kit (referred to in this License
Agreernent a5 the "SDE” and specifical_l[y including the packaged ARls) is subject to
the terms of this License Agreerment, This License Agreernent forms a Ieial\y
binding contract between you and Google in relation to your use of the SDE,

1.2 "Google” means Google Inc,. a Delaware corporation with principal place of
business at 1600 Amphitheatre Parkway, Mountain View, CA 94043, United States,

1.3 This version of the Android S0K is being offered to the developer community on
an “Early Look” basis, With the help and input of the developer cormmunity, Google
will continue 1o add new functionality and features to continually improve the SDE,
Once the SDK reaches a more finished form, Google intends ta'release mast of the
corponents under the Apache v2 0 open source license,

2 Accepting this License Agreement |

|®§!__gcceut the terms of the license agreements:

(1 do not accept the terms of the license agreements

@ [ Finish ][ Cancel
2lo|MA S0 21, Finish HHES 22 3IC
2 Ch3at 22 AX| 2tHO0| LEtLIHAM HX|E A%} ot

= Install @

j:) Operation in progress,

| J

Downloading org, apache, #ml, serializer

[ JAlwaysrun in background:

[Hun in ﬂackgrnund] [ Cancel ] [ Detailg > >

X7t o} E[H ch=at

F

- Software Updates

1

effect, For some add-ons, it may be

2

It is strongly recommended you restart Eclipse S0k for the changes to take
i | possible to apply the changes vou have
rmade without restating, Would vou like to restart now?

[ Mo ] [.ﬁ.ppll_.,.' Changes]

Yes HES 22| o}0] eclipseE LCiA| Al
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google®| developer android ZHO|X|0|A sdkE& CtRZE BH=C}

http://developerandroid.com/sdk/1.1_rl/index.html

l@ Android 1.1 SDK, Release 1 (1.1_r1) | Android Developers - Microsoft Internet Explorer =)
M BEE 22N SAFNA 2D SH) a.
Q% O WEGLuEome ase Lals

2 410) [ ] hitp://developer, android, com/sdk/1, 1_r1/indes, hirm M Elois =2 Google 8+l sty Search  » & - () 5ignn -
and>3oi> Android com

developers

Home il "d Dev Guide Reference Blog Community

search developer docs

~
Current SDK Release | [l
Download Android 1.1 SDK, Release 1
Installing
Upgrading
System Requirements Febriay 2000
SOK Terms and Conditians
S0k Release MNotes Before downloading, please read the System Reguirements document. As you start the download, you will also need to review and agree to the Terms and Conditions that
Android System Images govern the use of the Android SDk.
Android 1.1 Wersion MNotes £
android 1.0 DK, releass 2 Windows android sdicwindows 11 1 zlp| B6038515 bytes BcdbO0A0b4I0026370689 80342064210
Andraid 1.0 DK, release 1
Older Releases
Mac O3 X (intel) android-sdk-rmac_x86-1.1_rl.zip 79046151 bytes  becflf1763d61eedce15d24903d6c1 dd
Linw (i386) android-sdk-linuy_xB86-1.1_rl.zip 79345522 bytes ebcb1Bh0cddaefl 98h4ddDal 4186
SDK Contents
Development tools
The SOK includes a variety of tools for developing and debugging application code and designing an application UL ¥ou can read sbout the tools in the Dev Guide and
access them inthe <sdk>/tools/ directory.
The tools package included in this SDI iz the same as that included in the Android 1.0, Release 2 SDK.
System Images
The Android systern images listed below are included in this S0K. For maore information about a system image — features, applications included, localizations, API
changes, and o on — see its Version Notes. [we]
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http://developer.android.com/sdk/1.1_r1/index.html

|@ Download the Android SDK | Android Developers - Microsoft Internet Explorer
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Q=-© ®XRA®B L e B-LUJAE 3
(D) | htip://developer. android. com/sdk/download. hml?v=android-sdk-windows-1. 1_r1. zip v E 0s 9“2 ¥ Go gle 8~ s~ Search « > o - Sign In -
Home Dev Guide = Reference Blog Community
~
C SDK Relea . i
Current elease 1 . Introduch()n
Download
Installing
Upgrading 1.1 The Andraoid Software Development Kit (referred to in this License Agreement as the "SDK” andl specifically including the
System Requirements Android system files and packaged APIs) is licensed to you subject to the terms of this License Agreement. This License
SOK Terms and Conditions Agreement forms a legally binding contract between vou and Google in relation to your use of the SDK.
SDK Release Motes
Android System inages 1.2 "Google" means Google Inc., a Delaware corporation with principal place of business at 16800 Amphitheatre Parkway. Mountain
Ancroid 1.1 Version Notes View, CA 34043, United States,
Previous SDK Releases - - H
o3 1.0 50K refoase 2 2. Accepting this License Agreement
Android 1.0 SDK, release 1
Older Releases 2.1 In order to use the SDK, you must first agree to this License Agreement. You may not use the SDK if you do not accept this
License Agreement.
2.2 You can accept this License Agreement by:
(&) clicking to accept or agree to this License Agreement, where this option is made available to voui or
v
‘ | agree to the terms of the Android SDK License Agreement
File: android-sdk-windows-1.1_r1 zip
T Gototop
Site Terms of Service - Privacy Policy - Brand Guidelines:
<
A S L HAE EH & = k=3 S
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2hdst=l Download HHES 28510 android-sdk-windows-1.1_rlzip IS Z2Z C|HEZ|
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22 g2 CHE(CWmokyo_android) £ 0lS 6t mI2S SEMELH L2 YW
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= Java - Eclipse SDK L:J@
File Edit Navigate Search Project BRun \Endo%\ Help

> = B
(@) Welcome 53 ,NEW dow i -

|
/ Open Perspective
Show View
Customize Perspective,,,
Save Perspective As...
Reset Perspective,.,
Close Perspective
Close &ll Perspectives

Mavigation

Window -> Preferences & =2 Preferences CIO|YZ21E | 2LC}



type filter text €3 Value must be an existing directory = -
- General .
= andraid &Android Preferences
Build SDE Location:
DOMS
Launch
LogCat
Usage Stats
+- &nt
; :1‘?3 = Android SDK Location
* T—L? The location of the &ndroid SDE has not been setup, Please go to Preferences
- T @ » dndroid and set it up
+-FRu
- Te
+ ]

Restore Defaults

2|9t Zto| Lt ™, Ct8ut Z+0| Android SDKe| 9|X|& X|& 3iC}

Android SDK9| & X|=
C:\mokyo_android\android-sdk-windows-1.1_r1\android-sdk-windows-1.1_r1
o|ct.



= Preferences (=

type filter text Android =
Generlal Android Preferences
=-Android
Build DK Lacation: vs-1, 1_r1¥android-sdk-windows-1,1_r1
DDMS
Launch —
LogCat =0 ZrokE |
Usage Stats
Ant
Help
Install/Update
dava = [ mokyo_android ]
Plug-in Development = I3 android-sdk-windows-1,1_r1
ﬁrun/Dehug = I iandroid-sdk-windows-1,1r1
eam
ML ) docs ([
=) samples
() toals
) usb_driver
I eclipse-50K-3, 4, 2-win32 M
=M android-sdk-windows-1,1_r1
TEEECENT L= Lz |
[Hesture Qefaults] [ Apply ]
@ ( 0K | [ Cancel |
Browse.. Eg 282 30, Android SDKO| <2X| (C:\mokyo_android\android-sdk-windows-

1.1_rl\android-sdk-windows-1.1 r1) £ MEH st1, =0l HES EEl St}



r = Preferences @

type filter text Android ¥

+- General
= Android
Build SDE Location: |vs-1,1_r1Wandroid-sdk-windows-1,1_r1| f Browse,
DOME
Launch
LogCat
Usage Stats
&nt
Help
Install/Update
Java
Flug-in Developrment
Fun/Debug
Team
ML

&ndroid Preferences

I I O B Y B

[Hestnre Qefaults] [ &pply ]

)] [ o] 4 ] [ Cancel ]

OK HE= 28 o0, SDKe| 2785 OplC.
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eclipse O A{ File -> New -> Other.. 22l i}

= Java - E[:Iipse SDK
File | Edit MNawigate Search Project Bun  Window Help
| New Alt+Shift+M ¥ 3¢ Java Project
Open File,,, = Praject,.,
Llose CArl+f H Package
Close Al Ctrl+Shift+if & Class
[E] Save Ctrl+ € Interface
Bl Save As.. & Enum
[ Save Al CirleShiftes | @ Annotation
Rever &Y% Source Faolder
Mave. .. 1= Java Working Set
Rename... F2 (% Folder
&) Refresh F5 | File
Convert Line Delimiters To v [Z7 Untitled Text File
— 7 JUnit Test Case
&y Print,., Cirl+P
% E le...
Switch Workspace J CAample
Restart = Other.., Cirl+M
£2g Import W
5 Export
Properties Alt+Enter
Exit
22 o5 3Tt 20| New Project® A% + Ut BY 0| LbEPHLE
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Select a wizard

Wizards:
‘type filter text |

----- &4 Interface

1% Java Project

----- £ lava Project frarn Existing Ant Buildfile
----- 2 Plug-in Project

#-[= General
[H-= TWS
0= Java
#-(= Plug-in Development
#-= User Assistance
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#-= Examples
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«= New Android Project

Ex]

New Android Project
Creates a new Android Project resource,

Froject name:

Contents
|® Create new project in workspace

() Create project from existing source
Use default location

Froperties
Fackage name: [kr.orkelp,android|

Activity name:
&pplication name: |Hello Android

|  Finish | [ Cancel

Hello Z2MEZ 2|9t Z0| 2= Lf
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|= dJava - Hello/src/kr/or/kelp/android/HelloActivity.java - Eclipse SDK ==
File Edit Source FRefactor MNavigate Search Project Run  Window Help
M S B0 R  EE G @ P8R o 5 8 dava |
{2 Packege E iz - fe Hierarchy] = 0 |[ [5) HelloActivity, java 52 = B1/5 outline 52 =g
B & ¥ package kr.or.kelp.android; 3 e w ¥
= 1% W Ly
= = Hello s . . &4 kror.kelp,android
=GB sre @#import android.app.kctivicy:[] 4 impart declarations
=3 kr.or kelp.android B = @ Hellodctivity
1) HelloActivity,java public class Hellokctivity extends Aetivity { . onCreate(Bundle)
[ R.lava /7% Called when the activity is first created. =/
=, Andrald Library ©  Boverrice
= assets - public void onCreate(Bundle savedInstanceState) {
& res super.onCreate [savedInstanceState) ;
a AndroidManifest xml setContentView(R. layout.maiz) ;
+
i
(<] i J2]
[ Prablems 22 @ Javadoc}@ De:lara(ian] ¥ =0
Oitems
Description = Resource Path Location | Type
ip® | witable | Smartmsert | 111
== N KX | ;1 | Ol"'H I-E‘II- A | ||— | -I - 2 =HE| & A6H "'H = |-
SAS AAH E7| Q8 Ct2aF 20| Run( HFHA Run->Run & 28 )& ¢ 8 2C
lé Java - Hello/src/kr/or/kelp/android/HelloActivity.java - Eclipse SDK =)
File Edit Source HRefactar Mavigate Search Project [Hon| window Help
i lwils 2 MR | %EUE Al & & d |
Debug
ackage ) ierarchy vt = Outline 23
[# Packs E Hi hy| = 8 Hell i = B/ 5 outh =0
L e e : AT
= = Hello s Fun C_nnﬁgura(inns &4 kror.kelp,android
Fimport — “= import declarations
. Debug History 4 = @ Hellodctivity
puhll;:* Debug &s » B @ . onCreate(Bundle)
go Debug Configurations,., /
Andraid Libran -
g ascets v - publ 34 feferences, te) {
= res <&p Al Instances, ,, Ctrl+Ehiftel
a AndroldManifest, xml E¥Watch
, ’ @ Inspect CtlShifsl
i) Display Cirl+5hift+D
QExecute Cirl+l
FEorce Return Blt+Shift+F
Step Into Selection
@ Toggle Breaknoint CirleShiltsB
@ Toagle Line Breakpaint
® Toggle Method Breakpoint
&% Toggle Watchpoint
s, Skip All Breakpoints
e Femave All Breakpoints
Jg Add Java Exception Breakpoint,,,
(© Add Class Load Breakpoint, .,
Gy External Tools 3
<] m =
[ Problems 52 @ Javaduc}@ Declaralimﬂ ~¥ =8
Oitems
Description Fesource Path Location | Type

kr.or kelp.android, HelloActivity, java - Hello/sre
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@ Java - Hello/src/kr/or/kelp/android/HelloActivity.java - Eclipse SDK
File Edit Source FRefactor Navigate

il E

Search Project Run  MWindow Help

N L AR AN

o 401 El e 5[ Java |
{8 Packege B 22 S Je Hierarchy] = 0 |[[5) HelloActivity java 52 = B1/5 outline 52 =g
B% < package kr.or.kelp.android; BR e ™
= = Hello s . . &4 kror.kelp,android
=GB sre @#import android.app.kctivicy:[] P impart declarations
= kr.or kelp.android =@  HellaActivit
® m He\lu&:tivilvjava public class Helloictl S Hun As = EE @ onCregte(Eundle)
0 Rleva /7% Called when t -
=\ Android Lihrary Foverride Select a way to run “Hello™:
(= assets = public veid onCre < iéndraid Application
& res super.onCreatq ava AppTel
a Andraidianitest xml setCentent¥iew | [ Java Application
' JuUnit Test
i
Description
Description not available
®

[ iz
[Z Prablems 2 @ Javadoc}@ De:lara(ian] ¥ =0
Oitems
Description = Resource Path Location | Type
o* kr,or kelp, android, HelloActivity java - Hello/sre
ot
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=] Android Emulator (5554) (=)

1 2 3 45 6 7 8 9 0
QWE RTY UTI O°WP
ANDROTD ASDFGH | K L @
£ Z X CV B N M <
sYM @ — / .

Android X£7| 715 2HO|H HA| 2
“Hello World, HelloActivity”
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Hello Android
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